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Abstract: Miss Universe, with a history spanning over 71 years, is regarded as the most prestigious beauty 
pageant worldwide. It was first held in 1952 and has continued its legacy, playing a crucial role in 
empowering women in the changing times by Phongpaichit (1989) and Malik et al. (2023). Malaysia has 
participated in Miss Universe since 1964 and achieved notable success by reaching the top 15 in 1970 by 
Abdul Hamid et al. (2015). The main objective of this research is to incorporate the Iban folklore figure, 
Goddess of Kumang, into the idea of Malaysia's national costume for the Miss Universe pageant. The 
research follows a qualitative approach, focusing on the practice and artistic experimentation to illustrate the 
representation of the Kumang Goddess in the National Costume, based on Peirce's Theory of Atkin (2010). 
The data collection process encompasses observation, documentation, and visualization methods to 
elucidate each step undertaken while producing illustrations. The research outcomes yield numerous fashion 
illustration concepts centered around the theme of the Kumang Goddess. The significance of this research 
lies in its endeavor to preserve and introduce a fresh dimension to the fashion industry by incorporating 
folklore characters as creative inspirations in artistic work. 
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1. Introduction 
The Miss Universe National Costume Competition is a captivating segment of the Miss Universe 

pageant where contestants from different countries showcase unique and culturally significant costumes that 
represent their respective nations. This competition allows contestants to celebrate their country's heritage, 
traditions, and symbols while providing a platform to promote cultural diversity and understanding 
internationally. The National Costume Show has become a much anticipated and visually spectacular part of 
the Miss Universe pageant, drawing attention from viewers worldwide. It is a vibrant display of creativity, 
craftsmanship, and national pride, making it a memorable and exciting aspect of the overall competition. In 
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this competition, the National Costume Show emerged as a captivating segment highlighting significant 
cultural themes from the participating countries. Throughout the Miss Universe competition, Malaysia 
showcased a variety of ideas and themes while presenting its National Costume. For instance, in 2011, 
Deborah Henry brought forth the theme of Wau Bulan, designed by Amir Luqman. Similarly, in 2018, Jane 
Teoh portrayed the theme of Perahu Bangau, designed by Salleh Hamid. In 2019, Shewta Shekon graced the 
stage with the theme "A Peranakan Indulgence," designed by Carvin Ong. 

 

   

Figure 1. Malaysia Inspired National Costume at Miss Universe Competition (Sources: Google Im-age,2023) 

After the formation of Malaysia on 16 September 1963, which resulted from the amalgamation of 
Tanah Melayu, Sabah, and Sarawak (Azilah Mohamad et al., 2020), the nation became rich with a diverse 
wealth of culture and art. This amalgamation unified us into one nation. Among the representations of this 
cultural diversity are three national costumes inspired by Sarawak's culture that have graced the Miss 
Universe stage. In 1994, Liza Koh, a Miss Universe Malaysia finalist from Kuching Sarawak, showcased 
the Iban traditional costume, Ngepan Iban, during the Miss Universe pageant. Then, in 2007, Adelaine Chin 
Ai Nee wore the Urang Ulu costume. Continuing this tradition, in 2014, Sabrina Bennet appeared with the 
concept of "The Goddess of Kenyalang," designed by Adila Long. Remarkably, no national costume from 
East Malaysia has been selected for the Miss Universe competition (Suwardi, 2019). Therefore, this 
research aims to reintroduce artworks from Sarawak in the form of national costumes by highlighting a 
legendary figure from the Iban community, the Goddess of Kumang, as the central theme. The objective is 
to revive and celebrate the rich cultural heritage of Sarawak on the prestigious global stage of Miss 
Universe. 

 

   

Figure 2. National Costume Inspired by Sarawak Culture (Sources: Google Image, 2023) 
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Incorporating folklore or cultural characters into fashion is a recurring theme in the fashion industry, 
and it continues to be explored innovatively. A recent example of this trend can be witnessed in the Haute 
Couture Fall 2022 fashion show by Balenciaga, where designer Daniel Roseberry skillfully blends heritage 
and creativity, drawing inspiration from the iconic styles of Haute Couture during the era of Christian 
Lacroix and Jean Paul Gaultier. Similarly, the Dior 2022 fashion show, curated by designer Maria Garzia 
Chiuri, also embraces this concept. Chiuri takes inspiration from the works of Olesia Trafymenko, an artist 
from Ukraine, particularly focusing on her favorite motif, the Tree of Life, which serves as the central theme 
for the collection. The Tree of Life holds deep cultural significance, symbolizing folklore and hope for life 
among human beings (Bruce-Mitford, 2019). These instances demonstrate how the fashion world 
continually draws from folklore and cultural elements to create captivating and meaningful collections. 

In modern society, the assimilation of national cultures stands out, each boasting a unique color palette, 
harmonious forms, and proportions. These national characteristics are preserved by interpreting culture and 
art's rich experiences and achievements within contemporary design. It is particularly evident in how 
elements of traditional national dress are transformed to influence clothing designs. The traditional costume 
is an endless inspiration for fashion collections, with its strong ethnic identity and original components. The 
cuts, embroidery, decorations, jewelry, and color combinations showcase its various regional traits. 
Renowned fashion designers like John Galliano and Jean Paul Gaultier creatively interpret folk costumes, 
infusing new solutions into modern clothing. They skillfully rethink the traditional elements of clothing, 
satisfying the demand for creative and artistic advancements in fashion design. The method of 
deconstruction is often utilized in creating author's collections, allowing designers to manipulate forms and 
challenge conventional clothing modeling techniques freely. This approach allows designers to unleash 
their creative potential and produce original women's clothing that accentuates the wearer's individuality. 

In addition to deconstruction, methods of association and stylization are employed to transform the 
constructive and decorative characteristics of folk costumes into contemporary fashion models 
(Gerasymenko et al., 2020). These techniques ensure that folk elements remain relevant and influential in 
the dynamic world of fashion, showcasing different nations' rich diversity and cultural heritage. The 
incorporation of historical costume elements into contemporary fashion has become a prevalent practice 
(Chen, 2011). conducted research on Chinese ethnic costume culture, successfully combining the extraction 
of costume elements with modern fashion design to achieve both the inheritance and innovation of ethnic 
costume culture. Additionally, Kuzmichev et al. (2017) pointed out that some fashion designs now draw 
inspiration and design elements from historical costumes. Zhang (2021) analyzed the application of 
elements from opera costumes in modern fashion design, creating modern clothes infused with opera 
elements. This research provides valuable insights and ideas for the potential application of opera elements 
in contemporary fashion in the future. Moreover, Lee and DeLong introduced the concept of "re-birth 
design" (Chen, 2011; Lee & DeLong, 2018), adding to the growing body of work that showcases the fusion 
of historical and modern elements in fashion design. 

Malaysia is known for its rich and diverse cultural heritage, with a population comprising various races 
and religions. Folklore, an integral part of the indigenous communities in Malaysia, serves multiple 
purposes, such as religious expression, entertainment, moral education, and life guidance. This research 
focuses on the goddess figure known as the "Goddess of Kumang" from Iban folklore in Sarawak. The Iban 
community represents the largest ethnic group in Malaysia, with an estimated population of around 809,600 
people in 2018, according to statistics from the National Registration Department (2019). Traditionally, the 
Iban people practice communal living in longhouses and rely mainly on hill paddy cultivation as their 
primary economic activity. In the past, they were renowned for their bravery and warrior-like 
characteristics, often engaging in headhunting expeditions across the island of Borneo (Kiyai @ keai & 
Tugang, 2020) 
 
1.1.Who is Dewi Kumang 

The Goddess of Kumang holds a legendary status in the traditional literature of the Iban community. 
She is depicted as a beautiful and kind-hearted woman with exceptional skills in weaving pua kumbu. 
According to beliefs, she possesses magical powers, capable of healing the sick, aiding experts in 
craftsmanship, and instilling courage in Iban warriors during times of war (Kiyai @ keai & Tugang, 2020). 
In the oral tradition of the Iban, Dewi Kumang is revered as a princess who wields significant influence over 
the life of the community. Her origin is attributed to a village called Gelung Batu Nakong, which is believed 
to be situated in the sky. She is recognized as the sister of Dewa Tutung and is married to Dewa Keling, 
residing in Panggau Libau, a sky-dwelling village for Dewa Keling (Ganing & Amat, 2017). Although the 
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presence of Dewi Kumang and her magical powers may not be visible to the naked eye, she is said to assist 
fortunate individuals. Metcalf & Masing (1998) note, “Orang panggau only helps a selected few, and when 
that help is given, it is usually made known to the person concerned in a dream.” It implies that only a 
chosen few receive her aid, and it is often revealed through dreams to the person in need. Every year, on the 
1st of June, the Gawai Dayak festival is joyously celebrated among the Dayak people in Sarawak and 
Kalimantan. The Gawai ceremony serves as a symbol of gratitude and appreciation to Petara (God) for the 
successful conclusion of the rice harvest season. During the festival, a Pekit Kumang competition is 
organized, where a young Iban girl is chosen as the beauty queen. This event is meant to honor and 
commemorate the significance of Dewi Kumang in the Iban belief system, representing beauty, gentleness, 
and exceptional skills in weaving cloth (Kiyai & Anak Tugang, 2021). 

2. Materials and Methods 
This research adopts a qualitative approach, specifically utilizing the Research on Practices 

methodology. Data is collected through visual observation of the existing Ngepan Iban and relevant cultural 
materials that inspire the ideas explored in this study. The study thoroughly documents all the processes 
involved in creating the national costume, centered around the goddess figure of Kumang. This 
documentation includes: 

2.1. Idea of Visualization 
The primary focus in generating innovative ideas lies in the visualization process. To initiate this, the 

researcher conducts a literature review, delving into previous studies that pertain to the research direction, 
aiming to gain insights into their culture and identify any research gaps. Following this, group discussions 
are held to establish the theme and design concept, utilizing mood boards to aid in the process. 

2.2. Hardware Development 
A hardware circuit was constructed to validate the outcomes obtained through software simulations. 

The primary and secondary circuits employed in the wireless power transmission hardware are depicted in 
Figure 3. 

 
Figure 3. Visual board 

The research themes and concepts are introduced using the visual board method, aiming to provide the 
research group with a comprehensive understanding of synonymous images and visuals in Iban material 
culture, seeking inspiration. Furthermore, the visual board serves as a guideline for researchers in 
developing a contemporary portrayal of the character Goddess of Kumang in harmony with the culture and 
beliefs of the Iban community. The content showcased in the visual board encompasses textiles, various 
fashion embellishments, motifs, and accessories in traditional Iban attire, forming the core of the concept 
and design ideas. 
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2.3. The Sketch Process 
Once the design idea is established, the illustration sketch process will be initiated. This phase requires 

significant time and effort as it involves developing the style and structure of the design, ensuring its 
alignment with the chosen theme and concept. The sketching also considers the materials used, ensuring 
they suit Malaysia's culture, climate, and politics. Moreover, appropriate sewing techniques are carefully 
identified, ensuring that the fashion created is not merely imaginative but practical and relevant. 

 

   

Figure 4. Sketch proses 

The researcher has produced eight sketches, drawing inspiration from the visual board and carefully 
considering their relevance to the culture of the Iban people. This creative process spanned over two weeks 
and involved continuous refinement to achieve relevant, realistic, and contemporary ideas while preserving 
the Iban community's unique identity. The final sketch was selected with great care to ensure its originality, 
high innovation potential, and potential impact on the contemporary fashion industry in Malaysia and 
internationally. 

 

    

    
Figure 5. The early sketches 
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Figure 6. The final illustration 

After carefully reviewing the eight preliminary sketches, the process of choosing illustrations for the 
final design was undertaken. This selection process involved revisiting the objectives of the chosen themes 
and concepts established during the visualization phase. As a result, the ultimate sketch that emerged from 
this selection process is named the "Memoir Goddess of Kumang." 
 
2.4. Outline Trace Technique 

  

Figure 7. Outline Technique 

The pencil sketch of The Charm of the Goddess of Kumang will be scanned in PDF format (Portable 
Document Format) to be easily traced using the outline technique on computer software. The Outline Trace 
Technique is used in various fields, such as art, design, and image processing, to convert a continuous-tone 
image into a simplified outline or silhouette representation. It involves extracting an image's essential edges 
or contours while discarding fine details and variations in shading or color. Here is the process: 

 
1. Image Selection: Choose the image you want to convert into an outline. It could be a photograph, 

a digital image, or a scanned drawing. 
2. Image Preparation: If necessary, perform any necessary adjustments or preprocessing on the 

image. This may include cropping, resizing, or enhancing the image to achieve the desired result. 
3. Edge Detection: Apply an edge detection algorithm to the image. Edge detection algorithms aim 

to identify the significant changes in pixel intensity corresponding to the edges or boundaries of 
objects within the image. Common edge detection algorithms include the Canny edge detector, 
Sobel operator, or Laplacian of Gaussian. 

4. Thresholding: Once the edges are detected, apply a thresholding operation to convert the gray-
scale image into a binary image. This step involves setting a threshold value to classify pixels as 
either foreground (part of the edges) or background. 
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5. Post-processing: Perform any necessary post-processing steps to clean up the extracted edges. 
This may involve applying morphological operations like dilation or erosion to remove noise or 
smooth the edges. 

6. Optional Styling: Depending on the desired outcome, you may choose to add additional stylistic 
elements to the outline. This could include adjusting the line thickness, applying filters, or adding 
artistic effects to enhance the visual appeal. 

7. Output: Once the outline tracing is complete, you can save or export the resulting image in the 
desired format. The final output will be a simplified representation of the original image, con-
sisting of the essential edges or contours. 

 
2.5. Manipulation of images using Adobe Photoshop 

Adobe Photoshop is a widely used software program developed by Adobe Inc. It is primarily used for 
editing and manipulating digital images but also has many other features for graphic design, illustration, and 
photo retouching. Photoshop provides advanced tools and techniques for professionals and enthusiasts to 
enhance and transform images, including adjusting colors, cropping, resizing, removing unwanted objects, 
adding text, applying filters and effects, and much more. Manipulating images using Adobe Photoshop 
involves various techniques to alter, enhance, or transform images according to your desired outcome. The 
illustration that has been outlined will be digitally designed using image manipulation techniques in Adobe 
Photoshop. This technique is design experimentation on sketches that have been traced using outlines by 
combining images that have been selected based on Iban culture. The image is obtained from the website 
and adapted to see the appropriateness of the material, concept, overall style, and realistic background as 
determined during the visualization process. 

 
Figure 8. Manipulation image using Adobe Photoshop 

 
Adobe Photoshop is a powerful software used for image editing and manipulation. Here's a general 

overview of how the researcher manipulated images using Adobe Photoshop to create the Goddess of 
Kumang overall look: 

1. Opening an image: Launch Adobe Photoshop and open the image you want to manipulate by 
going to File > Open or using the shortcut Ctrl + O (Cmd + O on Mac). 

2. Working with Layers: Layers are fundamental in Photoshop manipulation. They allow you to 
separate different image elements and make individual adjustments without affecting the original 
image. To create a new layer, go to Layer > New > Layer or use the shortcut Shift + Ctrl + N (Shift 
+ Cmd + N on Mac). 

3. Selection Tools: Use selection tools to isolate specific areas of the image that you want to ma-
nipulate. Popular selection tools include the Marquee, Lasso, Magic Wand, and Quick Selection 
tools. Select the desired tool from the toolbar and drag it around the area you want to select. 

4. Transformation Tools: Photoshop provides various transformation tools to manipulate selected 
areas. These tools include Scale, Rotate, Skew, Distort, Perspective, and Warp. To access these 
tools, go to Edit > Transform or use the shortcut Ctrl + T (Cmd + T on Mac) while the selection is 
active. 

5. Adjustment Layers: Adjustment layers allow you to make non-destructive edits to your image. 
They provide a range of adjustments such as brightness, contrast, color balance, hue/saturation, 
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levels, curves, and more. To add an adjustment layer, click on the "Create new fill or adjustment 
layer" icon at the bottom of the Layers panel and select the desired adjustment. 

6. Filters and Effects: Photoshop offers a wide array of filters and effects that can be applied to the 
entire image or selected areas. You can find these options under the Filter menu. Popular effects 
include Blur, Sharpen, Distort, Stylize, and Render. Experiment with different filters to achieve 
the desired look. 

7. Retouching Tools: Photoshop provides retouching tools to enhance or modify specific areas of 
the image. These tools include the Spot Healing Brush, Clone Stamp, Healing Brush, and Con-
tent-Aware Fill. Select the desired tool from the toolbar and apply it to the areas you want to re-
touch. 

8. Layers Masks: Layer masks allow you to hide or reveal parts of a layer without permanently 
deleting pixels. They are useful for creating seamless blends, adjustments, and composites. To add 
a layer mask, select the layer you want to mask and click on the Layer Mask icon at the bottom of 
the Layers panel. 

9. Saving and Exporting: Once you are satisfied with your image manipulation, save your work by 
going to File > Save or use the shortcut Ctrl + S (Cmd + S on Mac). If you want to export the image 
for web or specific purposes, go to File > Export > Export As or use the shortcut Ctrl + Shift + E 
(Cmd + Shift + E on Mac). 

 
2.6. Theory of Research 

This research is grounded in Atkin (2010), also known as semiotics or semiotic theory, developed by 
the American philosopher and logician Charles Sanders Peirce during the late 19th and early 20th centuries. 
Peirce's theory presents a comprehensive framework for comprehending the functioning of signs and the 
production of meaning. According to Peirce, a sign can be any entity that represents something else in some 
capacity or aspect. These signs are not confined to physical objects but can also encompass words, gestures, 
sounds, and other forms of representation. Peirce categorized signs into three trichotomies based on their 
relationships: the sign itself (representamen), the object it represents (object), and the interpretant, which 
denotes the understanding or meaning derived from the sign. Additionally, Peirce identified three types of 
signs, or semiotic relations, that explain how signs are related to their objects. 

 
Figure 9. Peirce's theory of sign 

Source: Atkin (2010) 

1. Icon: An icon is a sign that represents its object by virtue of similarity or resemblance. It has some 
inherent similarity or analogy to the object it signifies. 

2. Index: An index is a sign that represents its object by virtue of a direct connection or correlation. It 
is physically or causally linked to its object. 

3. Symbol: A symbol is a sign that represents its object by convention or agreement. Symbols have an 
arbitrary or conventional relationship with their objects, established by a social or cultural context. 

3. Results and Discussion 
The design concept for the attire, Goddess of Kumang, draws inspiration from a reimagining of her 

persona as illustrated in Iban's literary works, encompassing both traditional tales and poetic expressions. 
The characterization of the Goddess of Kumang will be classified based on the themes that have been 
identified. To underscore the importance of the Goddess of Kumang within Iban culture, the fashion design 
proposed in this study will integrate the fundamental components of the Iban Ngepan style. Moreover, this 
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design will also consider the textile features, accessories, and embellishments that are commonly utilized by 
the contemporary Iban community in their Ngepan ensembles. 

 
Figure 10. Memoir Goddes of Kumang 

The artwork originates from the concept of the Memoir Goddes of Kumang. This creative depiction 
takes its cues from the persona depicted in the Iban people's folk stories. The idea is translated into the 
artistic rendition, utilizing the Avant Garde style to portray the Kumang Goddess as a warrior. This 
embodiment presents her as a resilient, bold, and graceful woman, revealing her gentle aspects. This 
representation of women as warriors holds significance in today's context as it signifies parity between 
genders and underscores their adeptness in navigating the challenges of the contemporary era. Furthermore, 
it captures the contemporary and competitive essence of female leadership in the 21st century. The 
empowerment of indigenous women refers to the deliberate and comprehensive efforts to enhance the 
social, economic, political, and cultural status of women belonging to indigenous or native communities. 
This empowerment seeks to address the historically marginalized position of indigenous women by 
providing them with the tools, resources, and opportunities to exercise their rights, make decisions, and 
actively participate in various aspects of their societies. Empowering Iban women in Sarawak involves a 
multifaceted approach that addresses their economic, political, social, and cultural well-being. Here are 
some manifestations of the contribution to the empowerment of Iban women: 

 
Figure 11. Empowerment of Iban Women 

1. Education and Skill Development: Provide access to quality education and skill development 
programs for Iban girls and women. This can include vocational training, literacy programs, 
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and business, agriculture, and technology courses, enabling them to secure better job 
opportunities and contribute to their families and communities. 

2. Economic Opportunities: Create income-generating opportunities for Iban women through 
entrepreneurship, cooperatives, and microfinance initiatives. Support the development of 
women-led businesses and provide training in financial management, marketing, and business 
planning. 

3. Land and Resource Rights: Advocate for and protect Iban women's rights to land and natural 
resources, especially given the cultural significance of land ownership within Iban 
communities. Ensure that women have equal access to land tenure, inheritance, and 
decision-making related to land use. 

4. Political Participation: Encourage and support Iban women's involvement in local 
governance, community leadership, and political representation. Offer leadership, advocacy, 
and public speaking training to equip them with the skills needed to make their voices heard. 

5. Health and Well-being: Improve access to healthcare services and information for Iban 
women. Address maternal health issues, provide reproductive health education, and create 
awareness about gender-specific health concerns. 

6. Gender Equality and Awareness: Promote awareness about gender equality and challenge 
harmful gender norms and stereotypes within Iban communities. Work with community 
leaders, elders, and men to foster a more inclusive and respectful environment for women. 

7. Cultural Preservation: Recognize and celebrate the cultural heritage of Iban women. Support 
efforts to preserve traditional knowledge, crafts, and practices. Empower women to take on 
roles as cultural custodians and educators within their communities. 

8. Legal Awareness and Advocacy: Enhance Iban women's understanding of their legal rights 
and avenues for seeking justice. Provide legal aid services and advocacy support to address 
issues such as domestic violence, land disputes, and discrimination. 

 
Figure 12. Memoir Goddes of Kumang 

3.1. The Arts and Representation 
Representational art encompasses various subjects, ranging from real-life elements like landscapes, 

objects, and individuals (Marriott, 2019). These artistic ideas draw inspiration from contemporary fashion 
adaptation and Avant-Garde styles. They are examined through the perspective of Representation Theory, in 
which each design component carries its significance and symbolism. Instead of relying solely on emotion, 
art is defined by its link to human perception, serving as a conduit for expressing manifestations, ideologies, 
cultures, and beliefs. The portrayal of design within this fashion wing embodies notions of freedom, 
bravery, and seriousness. Over time, indigenous women in the Malay Archipelago, including Iban women, 
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have encountered various forms of subjugation that have deprived them of their rightful entitlements. These 
include constraints on education, impartial trials, societal bias, and submission to a male-dominated social 
framework that governs their lives, marriages, and familial roles.  

They additionally confront difficulties related to sexual harassment and domestic abuse. Abdullah 
(2013) attributes the historical curtailment of indigenous women's rights to the sway of the feudal system. 
This conventional monarchical structure exclusively concentrated political, social, and economic authority 
in the hands of men. The motif found in Pua Kumbu is a design believed to have been unveiled to the Iban 
people through divine visions from gods and goddesses. In this specific pattern, the Pua Kumbu is enriched 
with the Buah Aji Bangkit motif, signifying the God of Keling, and the Nabau motif, embodying power and 
blessings as a large snake. In Iban mythology, the "Nabau" is a powerful and mystical serpent or dragon 
often associated with bodies of water, especially rivers. The Iban people are indigenous to Borneo, 
particularly in Sarawak, Malaysia, and Kalimantan, Indonesia. The Nabau holds significant cultural and 
spiritual importance within their folklore. 

 
Figure 13: Nabau Motive in Pua Kumbu 

The Nabau is often depicted as a guardian spirit of the rivers and is believed to possess supernatural 
powers. It is revered as a deity that controls the waterways and can bring blessings and curses to those 
interacting with it. The Nabau is seen as having the ability to shape-shift between its serpent form and a 
human form, making it even more mysterious and powerful. The Iban people have a deep respect for the 
Nabau, and various customs, rituals, and taboos are associated with it. Some beliefs suggest that encounters 
with the Nabau can lead to prosperity if respected but could result in misfortune if its rules are violated. The 
concept of the Nabau reflects the Iban's close relationship with their natural surroundings, particularly the 
rivers that are vital to their way of life. The mythical creature serves as a reminder of the interconnectedness 
between humans and nature and the need to maintain a harmonious balance. 

In Iban culture, "sacred motive" might refer to traditional motifs, designs, or symbols with significant 
cultural and spiritual meanings. The Iban people, also known as Sea Dayaks, are an indigenous group from 
the island of Borneo, primarily residing in the Malaysian state of Sarawak and the Indonesian province of 
West Kalimantan. They have a rich cultural heritage with intricate art, rituals, and belief systems. The 
traditional art of the Iban people often features intricate motifs deeply rooted in their spiritual beliefs, myths, 
and legends. These motifs can be found in various forms of artistic expression, such as weaving, tattoos, 
woodcarving, and beadwork. Each motif carries a unique meaning and might represent aspects of their 
worldview, cultural history, or connections to nature and the supernatural. It's important to note that Iban 
culture is diverse and complex, and the meanings behind specific motifs might vary among different 
communities or individuals. These motifs are part of the broader cultural tapestry that makes up the Iban 
identity and provide insights into their history, beliefs, and way of life. 
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3.2. Materials 
The Iban woven textile, known as Pua Kumbu, takes center stage in this design, showcasing its vibrant 

palette that frequently integrates primary shades like yellow, red, black, and white. The creation of Pua 
Kumbu follows a traditional local approach, progressing through multiple phases. The outset entails 
collecting forest plants that form the fundamental constituents for crafting Pua Kumbu. 

  

Figure 14. Pua Kumbu 

The Iban community places profound cultural and ceremonial importance on these textiles. Pua Kumbu 
textiles serve many functions, including being used as ceremonial wraps and attire and being present during 
significant events like weddings. The intricate patterns that embellish these textiles frequently showcase 
customary symbols and motifs, conveying the Iban people's vital narratives, myths, or spiritual convictions. 
Crafting Pua Kumbu textiles requires considerable expertise, a legacy transmitted across generations, 
underscoring the indispensable role of weavers in safeguarding this age-old art form and its cultural 
significance. In the contemporary context, Pua Kumbu textiles are treasured by the Iban people and 
recognized as valuable works of art esteemed by individuals worldwide. Their beauty and cultural 
significance transcend borders and make them cherished pieces appreciated by people from diverse 
backgrounds. The Iban community in Borneo perceives the environment not merely as a source of 
sustenance but as an integral part of their cultural identity and imagery. Forests, rivers, mountains, and 
plants hold unique meanings and representations in the community's understanding. They view the 
environment as a living spirit capable of helping, caring, and protecting against potential dangers. Using 
materials sourced from Borneo's nature, such as mengkuang and bemban leaves, symbolizes the Iban 
people's connection to their environment and finds frequent application in creating cultural artifacts. These 
leaves, often mentioned in the literature of the Goddess Kumang, hold particular significance as they are 
utilized in various ceremonies and rituals, including the making of patterned mats. 

 

  

Figure 15: Bemban leaves & Mengkuang leaves 

This design incorporates natural materials like bamboo, mengkuang (Pandanus amaryllifolius), and 
bemban (Donax grandis) as supplementary materials. This choice aligns with the population's 
demographics, as they continue to value forest resources as essential for their livelihood and spiritual 
beliefs. The relationship between nature and the Iban people is deeply profound and integral to their cultural 
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identity. Nature holds immense significance in their lives, including spirituality, subsistence, social 
structure, and traditions. Here's an exploration of the multifaceted relationship between the Iban people and 
nature. Traditional Iban beliefs are deeply rooted in animism, where nature is seen as inhabited by spirits. 
Every element of the natural world, from rivers and mountains to animals and plants, is believed to have its 
spirit. The Iban people connect closely with these spirits, seeking harmony to ensure protection, prosperity, 
and well-being. Rituals and ceremonies often involve offerings and prayers to these spirits. 

1. Historically, the Iban people have relied on subsistence agriculture for their livelihoods. They 
practice shifting cultivation, or "swidden farming," which involves clearing and cultivating a piece 
of land for a few years before moving to a new area. This cyclical process allows the land to 
regenerate naturally. This agricultural practice demonstrates their understanding of the need for 
sustainability and their dependence on nature's cycles. 

2. The forests hold immense cultural value for the Iban people. Beyond providing resources like 
timber, food, and medicinal plants, the forests are also places of cultural identity, gathering, and 
ritual activities. The Iban have a deep knowledge of the forests and their biodiversity, passed down 
through generations, shaping their interactions with the land. 

3. Nature is a constant source of inspiration for Iban's traditional arts and crafts. Their intricate 
weaving, intricate beadwork, and detailed carvings often feature motifs and designs inspired by 
animals, plants, and natural patterns. These creations serve as functional items and artistic 
expressions of their relationship with the natural world. 

4. Iban oral traditions are replete with stories, myths, and legends that incorporate elements of nature. 
These stories entertain and educate listeners about the balance and interconnectedness of the 
natural world. They often contain moral lessons about respecting nature and living harmoniously. 

 
3.3. Potential and Significance 

The potential and significance of this project can be categorized into four key areas. All four of these 
elements are important factors and potential sources of competitiveness in providing benefits to cultural 
sustainability, economic well-being to craft entrepreneurs, and conducive development to players in 
Malaysia's textile and fashion industry in general. 

 
Firstly, it involves the preservation of the Pua Kumbu, an Iban woven fabric, and the cultural 

significance of the Folklore Goddess of Kumang among the Iban people. Preserving folklore through 
fashion design is a creative and meaningful way to celebrate and honor cultural heritage. Folklore 
encompasses the stories, traditions, and customs of a particular community or culture, and fashion can be a 
powerful medium to convey these elements. This attire represents how the Iban people in Sarawak narrate 
and immerse themselves in the beauty of the deities they worship and how they translate this through an oral 
tradition to ensure it continues to live on in the collective memory of their society. The story that is not only 
about the Goddess of Kumang alone, but the power and sacredness of the 'pua kumbu' that are legendary in 
their culture is an essential thread to be preserved in this study to appreciate the historical masterpiece of 
textile art.  It also aims to support Sarawak's handicraft entrepreneurs in expanding their businesses into 
more contemporary handicraft markets.  

This study also emphasizes the development and expansion of the handicraft industry in Sarawak, 
rather than solely focusing on conservative sales for souvenir purposes to tourists visiting Sarawak. 
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However, these handicrafts can be elevated to become a jewelry commodity for fashion accessories based 
on ethnic and contemporary modern designs. It has the potential to be a significant driver in introducing and 
promoting Sarawak's handicrafts to a more global level. Thirdly, it seeks to invigorate the Malaysian fashion 
industry by showcasing the talents of young designers, especially students in higher learning institutions, 
allowing them to explore diverse fashion genres and remain competitive. Reviving and invigorating the 
Malaysian fashion industry based on ethnic concepts has significant potential. Malaysia is a diverse nation 
with a rich cultural heritage, comprising various ethnic groups such as Malay, Chinese, Indian, and 
indigenous peoples.  

Leveraging this cultural diversity can result in a unique and vibrant scene that appeals to Malaysians 
and the international market. Lastly, the project aims to foster a spirit of unity within Malaysia's multi-racial 
society by celebrating cultural diversity through the medium of the fashion industry. Celebrating cultural 
diversity through the medium of the fashion industry is a powerful and meaningful way to promote 
inclusivity, break down stereotypes, and foster cross-cultural understanding. Fashion designers can draw 
inspiration from different cultures while respecting their traditions and symbols. Designers can create 
unique and beautiful pieces that celebrate cultural diversity by incorporating elements from various cultures 
into their designs. Engage with local communities and cultural organizations to learn and understand the 
significance of various fashion traditions. It can lead to more respectful and informed approaches to 
incorporating cultural elements into designs. 

4. Conclusions 
In recent years, there has been a rising trend known as folklore fashion, which involves seamlessly 

merging the time-honored narratives, customs, and beliefs of different cultures with contemporary clothing 
styles. Folklore encompasses the cultural stories, traditions, and rituals handed down through generations. 
Fashion designers have found inspiration in these tales and symbols, using them to craft one-of-a-kind and 
captivating clothing designs. This article aims to delve into the historical background and impact of folklore 
on fashion, explore the recurring themes of folklore in the fashion industry, analyze how folklore fashion 
has influenced society, and offer advice on incorporating folklore elements into your style. By embracing 
folklore fashion, we can celebrate cultural diversity's richness and safeguard traditional practices while 
pioneering fresh and captivating fashion trends. In folklore-inspired fashion, infusing designs with symbolic 
motifs and patterns drawn from myths and legends becomes crucial in imbuing the creations with richness 
and significance. When these symbols are skillfully interwoven into clothing, designers craft items that 
captivate the eye while bearing profound cultural meaning.  

Folklore fashion allows designers to celebrate cultural diversity by drawing inspiration from various 
myths and legends. This approach results in unique collections that showcase the richness of human 
imagination and promote cultural awareness. Memoir Goddess of Kumang plays an important role in 
preserving cultural heritage and promoting cultural diversity in the Iban community in Sarawak. By wearing 
traditional dresses, people can connect with their cultural roots, support local craftsmanship, and celebrate 
their cultural heritage. The Memoir Goddess of Kumang innovation idea enables designers to create 
clothing with a deeper meaning through the integration of symbolic motifs and patterns. These garments 
captivate the eye and connect the wearer to the diverse cultural heritage from which they originate, fostering 
a sense of appreciation and pride in our shared Iban culture and heritage. 
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